


Preface 
 
I’ve written this handout to accompany my classes in Adobe Photoshop and it is my hope that it 
will explain some of the basic techniques used in the class as sometimes I ramble and other times I will 
not mention certain steps clearly in the mistaken belief that everyone knows the ‘‘simple’’ steps. 
Despite my best efforts, questions may still arise. Please feel free to contact me at 
1-800-239-5343 and I will be glad to clear things up. I only ask that you be seated at your computer 
with Photoshop open when you call (yes…I’ve had people call from their cell phones 
with complicated questions while racing down the highway). 
With the exception of some keystrokes, Photoshop is identical whether you are using a Windows 
machine or a Mac. I will state these for each platform when possible; however it is fairly 
easy to remember: 
Windows: Alt =  Mac: Option 
Windows: Control = Mac: Command 
Windows: Right-Click  = Mac: Control-Click (unless you have a two-button mouse) 
 
 
It has been said ‘‘Photoshop should be used as an emery board, not as a 
sledgehammer’’. Meaning, you should just use Photoshop to tweek your images slightly, 
not rebuild them, but where’s the fun in that? 

 
Now… let’s Pound on some Pixels!!!! 

 
 
Phil Scarsbrook 
Graphics Manager 
Adobe Certified Expert 
Capitol Filmworks 
Montgomery, Alabama 
phils@totalimage.com 
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HELP!  My Adobe is broke!
What to do when your Photoshop has fallen and can’t get up?

It’s 4 a.m., the morning of a big deadline and you’ve been 
working for 20 hours straight.  Your body and entire desktop 
are visibly vibrating from a caff eine buzz while your family 
is blissfully sleeping. You fi nally fi nish that 340-image senior 
composite, while envisioning much needed rest, you gleefully 
click save, and instead of the digital Nirvana that you are ex-
pecting, you are rudely presented with a dialog box that reads 
“Photoshop cannot complete this task because there is not 
enough memory (RAM)”. What??? You’ve lost hours of hard 
work?  Argh#@*^#&^#!

Adobe Photoshop is without a doubt, the most system re-
source hogging program that you will ever use; taxing both 
your computer hardware and your patience. Having served as 
the unoffi  cial Photoshop help desk for Capitol Color Imaging 
for the past 10 years, I think that I may have heard it all. What 
follows is a short collection of some of the most common 
questions, along with their possible solutions.

You try to open, or save a fi le and you see the message “Out 
of Memory,” “Scratch Disk is Full,” or “Not Enough Memory 
(RAM).”  Photoshop, like most graphics programs, creates 
temporary virtual memory fi les on your Hard Drive (HD) 
when you run out of physical RAM. Th e HD selected for this 
task (selected in your preferences) is called your Scratch Disk.  
Th ese temporary fi les can be several gigabytes in size and 
when there is not enough space available on your HD, you get 
a “scratch disk is full” error. Th e simple fi x is to clean up the 
HD by archiving, then removing the 6 months of shoots that 
you still have sitting on your desktop.  Ideally you would have 
a second internal HD assigned specifi cally as your Photoshop 
“scratch disk”.
Should you fi nd yourself in a situation where you cannot save 
a fi le you are working on because of a lack of RAM, you can 
usually solve the problem by clicking edit/undo/all. Th is will 
erase your clipboard and your history palette, thus hopefully 
releasing enough RAM to allow you to save the fi le.

Suddenly, through no fault of your own, you can no longer 
change the size of your brush using the left  and right bracket 
keys.  In actuality, you are changing your brush size, but all 
you are seeing is the crosshair and no brush shape. Th is is one 
of the most commonly asked questions. Th e simple solution 
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is to turn off  your “caps lock” key. Th e caps lock key is the keyboard shortcut that changes the cursor from 
“normal brush tip” to “precise”.

“When I use the eyedropper tool, it selects the background color instead of the foreground color!”
You have inadvertently clicked on the background patch in your color palette. Choose Window/Color. In 
the color palette, click on the foreground swatch to set the eyedropper to choose foreground.

“When I open an image, the background layer is locked. How do I unlock it?”
Almost all photos open with the background layer locked. To unlock it, you need to convert the back-
ground to a layer. Th e simplest way to do this is to double-click the background layer in the layers palette, 
and click OK in the resulting new layer dialog box.

“Could not open the fi le because an invalid jpg marker is found”
Don’t panic, Photoshop is very picky when it comes to reading jpg fi les. Very slight errors can cause PS to 
baulk.  Try opening the fi le in some other program and resaving it. It’s very simple to open the jpg in Inter-
net Explorer or Firefox. Once opened, right-click and “save image as” to another location on your desktop. 
You’ll be amazed how many fi les can be saved this way.

“I open a fi le and fi nd that most of the Photoshop adjustment options and fi lters are dimmed out and unavail-
able”
Check the color mode. Look under Image/Mode to check. A lot of the adjustments and fi lters are only avail-
able for RGB fi les. Many images downloaded from the internet have been converted to Indexed Color mode 
to reduce fi le sizes. If you receive images from a client that have been sent to a commercial printer, they may 
be in CMYK mode. You will also fi nd that some of the fi lters will not be available for RGB fi les if they are 16 
bit instead of 8 bit.

“Aft er I fl atten my image, my layer eff ects change or disappear”
In order to speed up performance, Photoshop uses a “quick screen redraw” at certain zoom ratios.  Th is 
quick but inaccurate redraw sometimes will create a false image.  Always check your images at 100% zoom 
(just double-click the zoom tool). It is a good idea to perform all critical adjustments and retouching at 
100% zoom. With CS4 you no longer have this problem if you have open GL enabled.

“Photoshop is just acting wonky”
Every time that you close Photoshop, you are rewriting and saving the “preference fi le”. Th is is the fi le that 
loads when you launch Photoshop that tells it how you want the program set up. Since this fi le is rewritten 
so oft en, it is easily corrupted.  If the program starts acting...well, just weird, you probably need to rebuild 
your preference fi le. You accomplish this by pressing the Control/Alt/Shift  (windows) or the Command/
Option/Shift  (Mac) simultaneously, immediately aft er launching Photoshop. Th is is a critical timing thing, 
so if you do not see a dialog box that asks “Delete the Photoshop settings fi le?” you missed and should try 
again.  Rebuilding your preference fi le is oft en referred to as the Chicken Soup for Photoshop in that it 
cures most problems. Be aware that this will reset the program as if you had just installed it. You will not 
lose your custom actions or other presets. It is ironic that the Photoshop preference fi le is not rewritten 
when you uninstall/reinstall Photoshop, so rebuilding the prefs is the only cure.

Now, let’s have a look at how we want to change the default preference setting.  I have listed only the chang-
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es that I recommend. Your mileage may vary.  Under the edit menu (windows) or Photoshop menu (Mac), 
choose “Preferences”.   

General
Change Image Interpolation to “Bicubic Smoother” (when uprezing your images, you want to use bicubic 
smoother. When downsizing, use Bicubic “Sharper”).  If you are using a wheel mouse, be sure to check the 
box “zoom with scroll wheel” as this will allow you to zoom in and out with your mouse wheel.

File Handling
Change maximize PSD and PSB fi le compatibility to “always”.  Th is will embed a fl attened version of your 
layered fi le for use in other programs as well as speeding up thumbnail rendering in Bridge. Uncheck “En-
able Version Cue” if you don’t use it. Unless you have several users sharing the same fi les over a network you 
won’t need it.

Performance
If you fi nd that Photoshop runs sluggish set the cache levels to 4.  Leave maximum RAM set to the default 
of 55% (windows) or 70% (Mac) unless you have more than 2 gigabytes of RAM on your system.  If you 
set this higher you run the risk of starving your operating system of RAM and this will cause Photoshop 
to slow down and sometimes actually crash (losing all of your valuable work)! . If you have more than one 
hard drive (recommended), you will want to choose any drive other than “start up” as your fi rst scratch 
disk. Follow down until you run out of drives and then choose your startup drive as the last scratch disk. 
DO NOT use an external drive as a scratch disk as this will degrade Photoshop’s performance.

Cursors
Check the box that reads “full sized brush tip” only if you wish to see a simulated version of your feathered 
curser (personally I don’t like this feature). Check “show crosshair in brush tip” to create a small crosshair in 
the center of your curser (this helps with precise cloning and painting).

Plugins 
If you have installed any third party plugins in a separate folder (recommended), you should check this box 
and select “choose” to browse to its location.  Having a separate plugins folder saves you having to reinstall 
your plugins if you should need to uninstall/reinstall photoshop, or if you should upgrade.

Type
I recommend un-checking Font Preview. Th is feature is a memory hog and adds little benefi t.  Turning off  
this feature has been known to radically speed up Photoshop on many machines.

Th ere are some other default settings that you will want to change:

Choose the eyedropper tool and on the options bar, change the sample size from “point sample” to “3x3 
average”.

Open any image and choose Image/adjust/curves. Double click on the white eyedropper and input the 
number 247 in each of the R,G,&B boxes. Click OK and then double click on the black eyedropper. Change 
the R,G,&B values each to 14 and then once again, click OK.  Now click on the “options” button and check 
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Color Management...
yes, it is mostly smoke and mirrors

“fi nd dark and light colors” as well as “snap to neutral midtones”.   Th en change the shadow and highlight 
clipping to .15.  Be sure to check “save as defaults” and then click OK.   

Entire careers have been built around color management books and seminars. Discussions revolving around 
color gamut, color spaces, profi les, etc, leave all but the geekiest among us bored to tears. Let’s distill color 
management down to its simplest components.
Th ere are basically three steps to color management for photographers.

1. Monitor Calibration
2. Photoshop Color Management
3. Proper output (printer) profi le

Calibrating your monitor:  If you have ever looked at a wall of TVs in an electronics store, you will notice 
that each set looks a little diff erent. Th e same is true of computer monitors. Calibrating brings your monitor 
to a standard where the images on your monitor look the same in your studio as they do at your lab or from 
your printer.

You must use a hardware/soft ware combo.  Th ere are many on the market ranging from $99-$500.  Th ese 
packages consist of a hardware device (puck) and profi ling soft ware that you install on your computer.  Be-
fore calibrating, be sure that you monitor has warmed up for 1 hour (especially for CRTs). Always calibrate 
with the ambient room light set as it would be when you are editing images. When prompted by the soft -
ware, I recommend as a starting point a TRC (gamma) setting of 2.2 and a white point of D65 (6500 de-
grees).  Monitor Calibration is not a one-time event. Ideally you will recalibrate weekly, or at least monthly.  
Monitor settings change (drift ) over time and you must maintain calibration.

Photoshop Color Management: Th e second step is to properly set up your color management polices in 
Adobe Photoshop.  Of the many color space choices, there are generally three used by photographers or 
designers.
1. sRGB IEC61966-2.1  (hereaft er referred to as sRGB)
2. Adobe RGB 1998
3. ProPhoto RGB

sRGB- Th is is the smallest of the three spaces, and must be used for any images displayed on the web, com-
puter monitors, or sent to a lab for printing.  It is unfortunate that at the current time, all professional labs 
(Fuji or Kodak) can only accept images in the sRGB color space. Th ere is hope that in the future, the pro-
duction soft ware used by labs will be sophisticated enough to handle the larger spaces.

Adobe RGB 1998-A larger color space than sRGB and ideal for images that may need heavy editing in Pho-
toshop. Th is is my color space of choice when printing on an inkjet printer, or sending fi les to a commercial 
off set print shop. It is a nice balance of color gamut and practical fi le sizes.
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ProPhoto RGB- Th e largest of the three, it is thecolor space of 
choice for fi ne art photographers who print their own work.  
It has been said that this space is so large that it “contains 
colors that only a dog can hear”.  It is actually is so large that it 
contains colors beyond what the human eye can perceive.

 To set up your color management properly in Photoshop, 
Choose Edit/Color Settings to open the color setting dialog 
box. Change the RGB working space to “sRGB IEC61966-2.1” 
. Th en change the RGB color management policies to “convert 
to working RGB” If you want this to work in the background, 
be sure to uncheck all of the “ask when” boxes at the bottom. 
Click OK.  If you are shooting RAW, you will also want to 
set your processing preference color space in whatever RAW 
processing program you use to sRGB.

Files sent to a lab for printing  must be 8 bit RGB jpgs or 
fl attened tiff s with a color profi le of sRGB. Files should not 
contain any additional channels or paths. Tiff  fi les should not 
be saved with LZW compression.

Th e fi nal leg of this color management tripod is the output 
profi le, more commonly called the printer profi le.  Each type 
of printer has its own unique set of inks, and these inks lay 
down diff erently on each type of paper. In order for your 
prints to match what you see on the monitor, you must cre-
ate a custom printer profi le for each printer and each type of 
paper, or use the printer manufactures’ own premade profi les.  
If you send your work to a commercial lab for printing, this 
last step is mostly mute.  For example, at CCI, in our produc-
tion area, we have 6 Fuji Frontiers (each with its own unique 
profi le) as well as  a 30inch ZBE Chromira.  We could send 
you a printer profi le, but you would never know which printer 
your order will be sent to. Combine that with the fact that we 
update our custom profi les on a regular basis, and you would 
be shooting at a moving target.  If you send your work out to 
any professional lab, or your local Costco for that matter, the 
best you can do is calibrate your monitor and use the proper 
color space.

If you are properly calibrated, your prints will appear very 
close to what you see on your monitor, but you must con-
sider the light source under which you are viewing the actual 
prints.  If you take a print and walk from room to room in 
your studio or home, you will see the print change colors 
under diff erent light sources. Fluorescents will make them 

Color setting panel
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appear green, incandescent lights will make them appear yel-
low. Always check your fi nal prints under either daylight or 
daylight corrected bulbs.

Th ere are many ways to correct images for density and color, 
but here are the easiest basic steps.  Since density (brightness 
and contrast) will shift  your color, you should always adjust 
density fi rst. Under Image/Adjustments/Levels . You will fi nd 
3 sliders directly under the histogram. Th e left  hand slider 
adjusts the shadows, the middle slider adjusts the mid tones 
and the right hand slider adjusts the highlights.

To brighten an image, drag the right hand or middle slider to 
the left . Th is will typically lower the contrast, so you will also 
want to move the left  hand slider to the right. To darken an 
image, fi rst slide the middle slider to the right, then move the 
left  hand slider as needed.  As stated on Page 3, take this
 opportunity to set your white and black points from their 
default settings.  Double click on the white eyedropper in the 
bottom right corner. When the color- picker appears, change 
the R/G/B boxes from 255,255,255 to 247,247.247. Th en 
double click the black eyedropper and change the R/G/B val-
ues from 0,0,0 to 14,14,14.

To Adjust color, useImage/Adjustments/Color balance. Sim-
ply move the sliders in the direction of the color that you want 
to correct.

Some photographers attempt to crop their digital images in 
Photoshop by using the Marquee tool or the image size menu 
selection. Please do not use that method! Th e fastest and most 
effi  cient method of cropping in Photoshop is to use the Crop 
Tool. Which is located on the main toolbar, and is the third 
tool from the top on the left -hand side.

Aft er you select the crop tool (keyboard shortcut “C”) , set 
your crop size and image resolution (pixels per inch) in the 
options bar located near the top of your screen. Th e example 
on the next page is for cropping an 8x10 at 300 PPI. At this 

Image Correction...
Th e fast and dirty way

Crop Tool

Crop tool

Color balance

Levels dialog box
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point, simply move your mouse to the upper left  corner of 
your image, hold down the mouse button, and drag down 
toward the bottom right. When you get the crop close to the 
area that you need, let go of the mouse button and use the 
“handles” at the corners of your crop selection to the crop 
area or click and drag inside the area to move the crop. When 
you have this just the way you want, press enter or double-
click in the cropped area to crop your image.  

1. Tool Presets save out your most common crop sizes and       
never have to key them in again!
2. Width of Crop- set crop width in inches.
3.  Reverse Ratio- Flip width and height dimensions.
4.  Height of Crop- set crop height in inches.
5.  Resolution- Set pixel resolution per inch. (usually 300 ppi 
for prints)
6.  Front Image- Sets crop dimensions and resolution to the 
front most open image.
7.  Clear- Clears all settings.

If you fi nd that your crop marquee wants to snap to the 
boundaries of your image, press and hold the Control key
 ( Command key on Mac), and you will be able to position 
with more control.

Remember…be sure to set the resolution! 300ppi for print 
output and 72ppi for on screen display.

You can use the crop tool to add a mat to your image.  Set 
your background color to be the color that you would like the 
mat to be, click and drag the crop tool across your image until 
it stops at the boundaries. Th en grab a corner of the crop box 
and drag out beyond your image area. Drag out to the size 
that you want, center the box and either press the return key 
or double-click inside the bounding box. You image will now 
have a mat around it.

Type options bar
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If you ever have to create a digital photo of artwork or old 
photographic prints, you can use the crop tool to automati-
cally correct for any distortion or misalignment of your cam-
era.  Just open your fi le in Photoshop and select the crop tool. 
Th en press the “clear” button on the crop tools option bar. 
Drag across you image loosely around the area to be cropped. 
You will notice that aft er you let go of the mouse, the option 
bar changes. Check the box next to the “perspective” option 
and then drag each of the four corners of the bounding box to 
the edge of the artwork. Double click inside the crop bound-
aries and your image will be straightened automatically!

Remember to save out your standard crop sizes as presets, so 
that you do not have to set them each time!

Anything that you do to an image in Photoshop damages the 
fi le.  Just rotating an image forces Photoshop to redraw, thus 
damaging the pixels.  Particularly destructive are density (lev-
els and Curves) and color corrections.  If you have ever tried 
to brighten an underexposed image and found noticeable 
postorization or banding, you have seen this.

If you brighten an image and then decide that you went too 
far and try to darken it back a little, you are doubling the 
damage, not undoing the previous damage.

Adjustment layers allow you a way out. Th ey are just “fi lters” 
that sit on a layer above your image and do not aff ect the 
pixels until you fl atten the fi le. Further more, you can go back 
and adjust them over and over until you or your client is
 satisfi ed.

To create an adjustment layer, you can either use the menu 
to choose layer/new adjustment layer, or simply click on the 
“new adjustment layer” button at the bottom of the layers 
palette. Just adjust the image the way you normally would, 
then click OK.  If you wish to readjust, just double click on 
the layer icon in the layers palette and readjust.  You can have 
multiple adjustment layers.  By default, adjustment layers will 
aff ect all of the layers below it. If you are working on a multi 
layered fi le and want the adjustment to aff ect just the one 

Adjustment Layers
What, why, and how?
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layer below, choose layer/create clipping mask.

Another advantage to using adjustment layers is the layer 
masks that come along for the ride automatically. Th ese masks 
quickly enable you to make adjustments to selected areas of 
the image. More on layer masks later.

Th e text tool in Photoshop behaves much the same way as it 
does in most word processing programs.  You select the text 
tool (keyboard shortcut T) and click inside of your image.  
Th e Type tool lets you add text to your image. You can format 
the text in many ways, using the options bar including font, 
size, style, color, alignment, horizontal or vertical orientation, 
kerning, leading, tracking, indenting, line spacing, and more. 
You can even stretch and warp the shape of the text in varied 
and interesting ways!
Select your font, font size and color and begin typing. You can 
set the type my clicking the checkmark in the options bar or 
by selecting another tool.  You will notice that when you type, 
a new text layer is automatically created.  You can reselect the 
type to edit by double-clicking on the “T” icon on the text 
layer in the layers palette.  You can copy and paste text from 
other programs. If you want to copy entire paragraphs, click 
and drag the text tool to create a text box to paste your copy 
into.  If you do not create a box, your pasted text will all be on 
one long line.

Introduced with CS3 was the use of Swashes. Swashes are 
extra swirled versions of letters.  Th is only works with certain 
open type fonts.  For example, if you type the name Brenda 
using an open type font, then highlight the “B” and click on 
the little arrow in the upper right hand corner of the charac-
ter palette, you will see a contextual menu from which you 
choose “open type, then swash”. Th e B will change from its 
normal script to an extra fancy B. Th is is great, especially for 
wedding composites.

Other common adjustments include leading, tracking and 
kerning.  Leading is the space between lines of text.  Photo-
shop defaults to auto, which is a little too much for my taste.  
You can adjust the leading to taste, but a good rule of thumb 
is to use the same leading as your font size. Tracking is the 

Th e Text Tool
Typography for fun and profi t

Swash Path

Swash example
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space between all of the letters in a line of text and kerning 
is the space between two characters.  Th e tracking and kern-
ing for most text, was designed for 12 point type.  If you use 
a larger or smaller size, you really should adjust them.  Th e 
quickest way to scream “I’m an amateur!” is to have too much 
space between your letters. You can easily adjust leading and 
kerning using the character palette, but use this shortcut for 
adjusting kerning.  First, position your type cursor between 
two letters, then pressing the alt key (option on Mac), use 
your left  and right arrow keys to adjust the spacing visually.

Layer masks make it easy to combine images placed on dif-
ferent layers. Layer masks defi ne the transparency level of 
particular areas. No change is made to the pixels themselves. 

To create a new layer mask, just click the “add layer mask” 
button at the bottom of the Layers palette. A white rectangle 
will appear next to the layer thumbnail. A layer mask is a 
grayscale image. What you paint in black will be hidden, 
what you p int in white will show, and what you paint in gray 
shades will show in various levels of transparency.
Th is has an advantage over using the erasure tool in that if 
you make a mistake, it is easily fi xed by painting over with 
white. If you’re working with more than one layer, oft en you’ll 
want parts of the layer(s) below the top layer to be visible. For 
instance, you might want to blend two photos together but 
show only certain parts of each photo.  For example, replacing 
the sky in a landscape photo.

In that case, you would simply drag the sky image over the 
landscape image to combine the two into a single fi le with two 
layers (the sky being the top layer). Resize the sky layer to fi t 
properly over the bottom layer.  Select the sky layer and press 
the add layer mask button at the bottom of the layers palette.  
Click on the white rectangle (layer mask) to select it. Paint on 
the image (with the layer mask selected) with black to allow 
the landscape at the bottom to show through. Again, Every-
where that you paint with black will hide the sky and show 
the landscape.  White areas will hide the landscape and show 
the sky. Here are some layer mask shortcuts:

Masks 
Th ey are not just for Mardi Gras.

Bridge only

Bridge with sky added

Layers palette with composited images

Character Palette
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Shift /click on the mask will temporarily disable it.
Alt/click (Option/click on Mac) on the mask will show the 
painted mask.
Ctrl/Click (Option/click on Mac) on the mask will make a 
selection around the masked area.

Open your color fi le in Photoshop and adjust as desired. 
Create a Hue-Saturation or Black and white adjustment layer
( click on the new adjustment layer button at the bottom 
of the layers palette and select hue/saturation or Black and 
White ), then make adjustments to make your image Black 
and white. You now have what appears to be a black and 
white image, however your color image is still beneath your 
adjustment layer. When you created the adjustment layer, you 
automatically created a layer mask (white box directly to the 
right on your adjustment layer). Click on the white box and 
select your paint brush tool and make black your foreground 
color. Everywhere that you paint on the layer mask will show 
through to the color layer below. If you make a mistake, just 
paint over the mistake with white. 

1. Open your image in Photoshop.
2. Duplicate the layer (Crtl-J).
3. Fill the background layer with white (or black if you want a 
dark edge).
4. Create a layer mask by clicking on the “create layer mask 
button” at the bottom of the layers palette.
5. Choose the paintbrush tool and make your foreground 
color black.
6. Click on the brushes palette and then click on the small 
black arrow in the upper right corner, then load the dry me-
dia brushes.
7. Select the brush numbered 20 near the bottom.
8. Enlarge brush to size using your bracket keys, then paint 
running along outer edge of image.
9. You can also hold down the shift  key and simply click the 
corners and Photoshop will paint a line between.

If you make a mistake, or do not like the eff ect, paint over 
again with a foreground color of white.  Play with diff erent 
brushes and brush sizes to create diff erent eff ects.

Localized Colorization using Layer Masks  

Adjustment layer with mask

Example

Creating Rough Edges 

Aft er
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Create a new layer by Alt/Clicking (option/click on a Mac) 
and you will see the new layers property box. 
Change the mode to Overlay (as shown) and then check the 
“fi ll with Overlay-neutral color” box. 
Th is will give you a layer (in overlay mode) that is fi lled with 
50% gray. Your layers palette should look like this: 
Choose your paintbrush tool and lower the opacity to about 
10% (your mileage may vary). As you paint with white, you 
will be Dodging and as you paint with black, you will be 
burning. Cool Huh?

One of the most overlooked features in Photoshop is the 
shadow-highlights adjustment.
It can greatly lighten dark backgrounds resulting from using 
fl ash in a very large area or recover some of the highlights 
when  blown out. It is also great for boosting fi ll fl ash in out-
door portraits. Th e fi rst step is to duplicate your background 
(Control-J on PC, Command-J on Mac), then use Image/
Adjustments/Shadow Highlight. Be sure to click on the “show 
more options” button to expand the dialog box.
Drag the amount slider under the shadows to the right to 
brighten the shadows without aff ecting the other tones. If you 
want to darken the highlights, increase the amount slider for 
them. Be sure to adjust the radius, tonal width, color correc-
tion and midtone contrast sliders as they will vary with each 
image.

Dodging and Burning the Correct Way 

50% gray layer in overlay mode

New layer dialog box

Shadow and Highlights adjustment 

Before

Aft er
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Creating class composites is a great revenue source for stu-
dios. It is very labor intensive, however by reusing templates 
that you have built and using keyboard shortcuts, they can be 
built very quickly. Here are the steps:

1. Create a new document to image size at 300 ppi.
2. Scan any logo(s) and save as tif fi les.
3. Copy and paste the logo fi le into your new document and 
size (Crtl-T) as needed.
4. Type in name of organization (school name, years etc) and 
size and position (use school colors if possible).
5. Create a new blank layer.
6. Using the rectangular marquee tool draw a small rectangle 
to represent the fi rst image.
7. Fill (edit fi ll) this rectangle with 50% gray.
8. Duplicate this layer (Crtl-J) and move the new box beside 
the old one.
9. Repeat this process until you have created enough boxes.
10 Arrange these boxes. Use your guides to help line them up.
11. Select all of the “boxes” layers and merge them (layer/
merged linked).
12. Add a stroke or drop shadow to the new “boxes” layer if 
you wish.
13. Open fi rst student image (most composites are in alpha-
betical order last names fi rst).
14. Select all (Ctrl-A), edit copy (Crtl-C). Close this docu-
ment.
15. Highlight the “boxes” layer in your composite (right-click 
on a box and choose the layer).
16. Select the magic wand tool (W) and click on the fi rst box.
17. (Cntrl-Shift -V) to paste your fi rst image into the box.
18. Press Ctrl-T, use a corner of the bounding box to resize 
the image as needed. Be sure to hold the shift  key while resiz-
ing in order to maintain your ratio.
19. Open your next image and repeat steps 14-17, but select 
the next box in line.
20. Press Crtl-Shift  T to transform the size of the image the 
same as the last one.
21. Repeat these steps until all of the boxes are fi lled. Save fre-
quently, you don’t want to have to do this all over if you have a 
power outage.
22. Create a new guide below the fi rst row of photos.

Building a class composite

Composite template ready to add images 
and names

Finished composite
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23. Press “T” for the text tool and type in the fi rst student’s name. (use an easy to read font such as Times 
New Roman).
24. Repeat until all names are typed (use the guides to line up the names properly.
25. Before fl attening layers, save a layered version to cd to use as a template for future composites.

Additional Ideas:

1. Use a script font for the school name or perhaps “Bliss” for an old English script look.
2. Use a gradient of the school colors on the background layer.
3. Incorporate a photo background (Flag for ROTC, Sheet music for Band) etc. (Be sure use the image on 
a layer just above the background so that you can drop the opacity of the layer and create a “ghosted” or 
faint look as not to interfere  with your text).

If your image is slightly crooked, then grab the Measure tool (it looks like a ruler and is hidden under 
the Eyedropper tool in your tool palette), and draw a line across the horizon,or edge of the image so that 
Photoshop knows which angle your image is at. Th en choose Image>Rotate Canvas>Arbitrary and use the 
default settings (which will be based on the angle of the line you made).

When Adobe came out with Photoshop 6.0, they added the Slice tool (it looks like an X-acto knife). If you 
ever mess with that tool, you’ll fi nd that Photoshop puts a gray rectangle with a “1” in it in the upper left  of 
all your documents. To get rid of that annoying rectangle, just choose View>Show>Slices. 

If you ever fi nd that all your tools show up as crosshairs when you move over your image, then either the 
Caps Lock key is on, or the settings in the Edit>Preferences>Displays and Cursors dialog box got set to 
Precise.

Opening and Saving Files:
Drag fi le over Photoshop icon to open fi le.
Double click anywhere in the work area to open fi le.
Double click with alt key anywhere in the work area to use “open as” feature.
Double click with Ctrl key (Command on Mac) anywhere in the work area to create new document.
Ctrl + S (Command +S on Mac)to save fi le.
Crtl+W (Command +W on Mac) to close a fi le
Shift  Clicking on the close fi le button will close all open fi les.

Navigation:
Ctrl +(plus sign) (Command + on Mac)to zoom in.
Ctrl - (minus sign) (Command - on Mac)to zoom out.
Double-Click Zoom Tool to size image at 100%.
Double-Click Hand Tool Crtl+0 (Command +0 on Mac) to size image to fi t screen.
Press Space bar and use mouse to move around image larger than screen.

Miscellaneous shortcuts and tips
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Making Selections:
Use Shift  Key to add to a selection using any selection tools.
Use Alt ( Option on Mac) Key to add to a selection using any of the selection tools.
Painting:
Use left  and right brackets on keyboard to enlarge and reduce brush size.
Press Alt (Option on Mac) while using any painting tool to access eyedropper tool.
Color / Density Correction:
Pressing the Alt (Option on Mac) key will remember the last color or density adjustment made.
Hold Alt (Option on Mac) key and you drag sliders in the levels dialog box will show the lightest and 
darkest areas of  image.
Misc:
Press the Ctrl (Command on Mac) key to temporarily disengage snap to borders when using the crop tool.
Ctrl +J (Command+J  on Mac)will duplicate your active layer or copy the current selection to a new layer.
Ctrl +Z (Command+Z on Mac)to undo last action.
Ctrl/Alt+ Z (Command/Option+Z on Mac) to repeatedly undo (step back through history palette).

http://www.adobe.com/support/forums/main.html -  Free-Adobe systems site, click on program of your 
choice to enter that particular forum. You will be asked to sign in. You can either register for the site (free), 
or you can log in as guest. Be aware that if you log in as guest, you will not be able to post questions or 
answers.

http://share.studio.adobe.com/Default.asp - Free-Site where you can download actions, templates, layer 
styles, etc. FOR Free!

https://www.photoshopuser.com/ - Paid Membership-Th e offi  cial site of the National Association of Pho-
toshop Professionals.  You must join the organization in order to enter the site. Membership is $99 a year, 
and provides a free subscription to Photoshop User Magazine, many discounts on hardware and soft ware, 
as well as access to the tips, tutorials, forums and free downloads.

http://tv.adobe.com/ - Free – Lots of free video tutorials from adobe covering all of the products.

http://www.planetphotoshop.com/ - Free-NAPP’s own Cory Barker’s Photoshop site with tons of video 
tutorials and industry info.

http://photoshopnews.com/ - Free- Jeff  Schewe’s site for everything Photoshop.

If you simply go to http:/www.google.com and do a search for “Photoshop Tutorials”, you will fi nd literally 
hundreds of free sites with tips and tutorials.

Photoshop Internet Resources
Some of my favorites
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Smart Object Templates
You don’t have to be smart to use them

We’re all lazy!  You may not be, but I certainly am. I hate 
doing anything twice (well, almost anything).  What’s this got 
to do with Photoshop you ask?  Templates, that’s what.  
By creating templates, we can use the same designs over and 
over without having to recreate the design each time. Th is 
works for all sorts of projects, for example, sports templates, 
cards, or album pages. Now, with the proper use of smart 
objects, you can work even “smarter”.

What is a smart object? A smart object is a fi le embedded 
within your Photoshop document that allows you to
transform it repeatedly without degradation of the image.
You can also replace the image with one click of the mouse. 
But, more on that later.

Let’s make a smart object template. Open any image. Unlock 
the background layer by either double-clicking the layer and 
choosing “OK” to change the locked background to a regular 
layer, or simply drag the lock on the background layer to the 
trash can at the bottom of the layers palette.  Now we make 
this image a smart object by right-clicking on the layer and 
choosing “convert to smart object” from the contextual menu.  
You will notice a small icon at the bottom right of the thumb-
nail in the layers palette  (image 1).

Next, duplicate this layer by either dragging the layer to the 
new layer icon at the bottom of the layers palette or simply 
use the keyboard shortcut Cmd/Jon Mac or Cntrl/J on PC. 
With the duplicate layer selected, choose edit/free transform 
(Cmd/Ton Mac or Cntrl/T on PC).

Holding down the Cmd and Option key (Cntrl and Alt on 
PC) drag one of the corner handles toward the center of the 
image . Holding down this combination of keys, not only 
constrains the proportions of your transformation, but centers 
it as well.  Add a drop shadow and stoke to the upper layer to 
help it stand out.

side note:  When applying a drop shadow or inner shadow, 
you can set the shadow position by moving your cursor 
directly over your image and dragging the shadow where you 

Image 1

Image 2
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want. If you would like sharp corners on you stroke, change 
the position to “inside” in the Stroke dialog box.

Th e last step is to apply an eff ect to the lower layer. Any eff ect 
will do, in this case I added the artistic fi lter Rough Pastels.  A 
Gaussian blur works nicely too.  Save as a layered fi le and you 
have a template (image 2).  A look at the  layers palette 
(image 3) shows what we have created.

Now for the fun part. Th e template can be opened later and 
applied to another client. Smart objects can be replaced with 
another image easily. In the layers palette, right click on the 
bottom smart object layer and choose “replace contents”.  
Browse to another image and select it.  Th e contents of both 
of your layers are replaced with the new image (image 4). 
Neat huh?

Next, let’s create a wedding template. Open an image, unlock 
the background, convert it to a smart object and duplicate the 
layer.  Th is time, we’ll reduce the size of the duplicate layer 
(free transform) and move it to the bottom left . Add eff ects 
such as drop shadow and stroke. Ghost back the bottom 
smart object by lowering its transparency to about 20%. 
Add the couple’s names across the top. In this case, I used a 
script font named Bickham Script Pro.  

side note: with certain Open Type fonts, you can add “swash-
es”, also known as glyphs. Th ese are embellishments that 
create a more ornate version of the letter. Using the text tool, 
highlight the letter, then using the character palette, click in 
the upper right corner of the palette and choose open type/
swash (image 5). Th is will convert the normal letter to a 
much more elaborate one (image 6).

Next, we’ll add a ghosted box for the body text. Create a new 
blank layer and using the rectangular marquee tool, draw a 
box and fi ll it with white.  Add an inner shadow layer eff ect 
and drop the fi ll of this layer to about 50%.  Using the text 
tool, add your body type over the box with a font of your 
choice (image 7). See the layers confi guration (image 8).
Save this fi le as a layered fi le in your templates folder and you 
have a wedding template that you can use again and again. 
Right click on the bottom smart object and choose “replace 
contents”, browse to a new image and viola’, you have new

Image 3

Image 4

Image 5
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 images replacing the old. Just change the text and you are 
good to go (image 9).

You get the point. Create templates in multiple sizes and save 
them as layered tiff  or psd fi les and you never have to redesign 
them again.  If you have never used smart objects, try them, 
you’ll like them.  Starting in Photoshop CS4, smart objects 
support smart fi lters. Th at is, when you run a fi lter on a smart 
object, you can go back later and change the settings of the 
fi lter to suit the new image.  Aft er you use the template, fl at-
ten all layers and choose “save as” to create a new document so 
that you do not overwrite your template.

 

Image 5

Image 6

Image 7

Image 8

Image 9


